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1. Presentación del encargo individual 
El encargo escogido para llevar a cabo de forma individual dista mucho de los encargos que se 

han visto en clase, pues consiste en traducir del español al inglés el cortometraje titulado La 

ruta natural, de unos once minutos de duración. Esto, como se verá más adelante, plantea una 

serie de problemas y retos para el traductor, ya que se trata de un tipo de traducción subordi-

nada. Por ello, dado que en la Facultad de Traducción e Interpretación de la Universidad de 

Granada sólo se oferta traducción audiovisual de inglés al español,  he considerado que se 

trataba de una buena oportunidad para sentir la experiencia de subtitular un vídeo de mi len-

gua materna hacia mi lengua B (inglés). A pesar del carácter audiovisual de este texto, conside-

ro que puede englobarse dentro de la divulgación, pues el argumento del cortometraje en 

cuestión no es sino un ensayo sobre la vida. 

En mi opinión, subtitular cortometrajes e incluso largometrajes del español hacia el inglés tie-

ne presencia en el mercado profesional de la traducción. Basta echar un vistazo a algunos fes-

tivales de cine para ver que gran parte de los cortometrajes que se exhiben son de proceden-

cia española. Debido a que quiero enfocar mi futuro profesional al mundo de la localización y 

la traducción audiovisual, y gracias a que cuento con la experiencia de haber subtitulado años 

atrás varias series de animación japonesa del inglés al español, me he planteado este encargo 

no sólo como un trabajo de clase importante para la nota, sino como un acercamiento a una 

posible realidad no muy lejana. 

La experiencia ha sido muy satisfactoria, y creo que me ha servido no sólo para refrescar y 

actualizar mis conocimientos sobre subtitulación, sino también para hacer una reflexión más 

profunda del lenguaje. En consecuencia, los problemas de traducción se han basado sobre 

todo en la reexpresión del mensaje original en la lengua de llegada de la manera más concisa 

posible y sin perder matices. Por tanto, la labor de documentación ha sido menos importante 

si se compara con los textos vistos en clase. No obstante, me ha sido muy útil ver la versión 

subtitulada en inglés de 7:35 de la mañana  —uno de los cortometrajes españoles más famo-

sos y premiados del director Nacho Vigalondo— antes de proceder a la traducción de La ruta 

natural. 

Este informe se divide en varios apartados. En primer lugar, se hace una breve descripción 

sobre el cortometraje elegido para la subtitulación y las instrucciones del encargo. En segundo 

lugar, se analiza la dificultad del proceso de subtitulación en su vertiente más técnica y los 

motivos que me llevaron a utilizar un determinado software. En tercer lugar, se hace una re-

flexión sobre los problemas de traducción encontrados de forma general y se detallan algunos 

casos concretos. En cuarto lugar, se describe brevemente cómo se han incrustado los subtítu-

los en el vídeo. Por último, el informe concluye con mi opinión sobre la consecución del encar-

go y las destrezas adquiridas. 
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2. El cortometraje: La ruta natural 

Este cortometraje, dirigido por el barcelonés Àlex Pastor Vallejo y de once minutos de dura-

ción, tiene un título que esconde el argumento de la historia que cuenta, ya que se trata de un 

palíndromo (es decir, se lee igual de derecha a izquierda que de izquierda a derecha). Cuenta 

la historia de Divad (nótese el palíndromo), un hombre que despierta de un extraño accidente 

en la bañera sin poder recordar nada. Así, el desarrollo del cortometraje se basa en el destino 

trazado e inalterable del protagonista, que empieza con su muerte y acaba con su nacimiento. 

Por ello, es una reflexión sobre el curso de la vida y sus componentes azarosos, un rebobinar 

de los momentos como si la vida fuera lo contrario: deslizarse desde la muerte al nacimiento. 

La ruta natural ha ganado muchos premios nacionales e internacionales desde su estreno en 

festivales de cine, como el Nuevo Talento Fnac de Cortometraje 2005 y el International Jury 

Prize Short Filmmaking. Esto indica claramente que ha sido subtitulado hacia el inglés, pero me 

ha sido imposible encontrar en la Red una versión con subtítulos, y desde la web del cortome-

traje nunca he podido lograr verlo. 

En este cortometraje no hay ninguna conversación entre personajes, ya que sólo se oye la voz 

del protagonista de fondo mientras describe los acontecimientos o reflexiona sobre ellos. Esto 

es vital para la traducción, ya que cada subtítulo debe tener el menor número de caracteres 

posible para que el espectador se concentre en las imágenes. 

3. El encargo de traducción 
El encargo requiere hacer una subtitulación íntegra del cortometraje, es decir, no basta sólo 

realizar la traducción. Dado que el director pretende ofrecer en su página web una versión de 

alta resolución de la versión subtitulada, ha decidido proporcionar un DVD de su cortometraje 

con el que poder trabajar y producir un archivo en formato AVI, que puede ser visualizado por 

cualquier reproductor multimedia para ordenador. Por tanto, lo ideal sería trabajar en colabo-

ración con un técnico subtitulador y un traductor, pero la cercana entrega de la traducción y 

las exigencias del mercado requieren a un traductor con conocimientos de informática, con-

cretamente de subtitulación. 

Dado que el cortometraje subtitulado se verá en la página web del director, sería irrelevante 

especificar dónde se puede encontrar más información en un posible subtítulo al final del cor-

to. Por el mismo motivo, es innecesario traducir los créditos del cortometraje. Además, la ver-

sión subtitulada en inglés del cortometraje 7:35 de la mañana, del director Nacho Vigalondo, 

tampoco ofrece traducción para los créditos. En cualquier caso, se presenta tanta información 

en la pantalla que no hay espacio para añadir subtítulos legibles. 
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4. El proceso de subtitulación 
El primer paso para llevar a cabo la subtitulación una vez se dispone del vídeo original en for-

mato AVI es marcar los tiempos de entrada y salida de los subtítulos, lo que en inglés se cono-

ce como spotting. Para ello, estuve barajando el uso de varios programas no comerciales, co-

mo Sabbu, AegiSub o VisualSubSync. Tras hacer algunas pruebas, comprobé que VisualSubSync 

era el programa que más se ajustaba a mis necesidades por las siguientes razones: en primer 

lugar, no es necesario separar la pista de audio del vídeo con un programa externo, ya que 

VisualSubSync se encarga de ello; en segundo lugar, permite visualizar tanto la onda de audio 

como el vídeo al mismo tiempo, así como previsualizar los subtítulos sobre el vídeo; y en tercer 

lugar, porque al lado de la caja de texto donde se escribe el subtítulo aparece el número de 

caracteres de cada línea. Además, es muy sencillo utilizarlo debido a que es muy intuitivo y, 

con un poco de práctica, se puede subtitular un vídeo sin grandes complicaciones. El programa 

guarda los subtítulos en formato .srt para que puedan ser reproducidos por reproductores 

multimedia como BSPlayer o Media Player Classic. 

Una vez están los archivos de vídeo y audio, basta con aumentar el tamaño de la onda de au-

dio (menú View > Zoom In) para poder apreciar los puntos en los que hay diálogos por la forma 

de la onda. A continuación, se selecciona el audio correspondiente a un subtítulo, se hace clic 

con el botón derecho en dicha selección y se pincha en Add subtitle. Ya sólo basta con escribir 

el subtítulo, guardarlo y repetir el proceso hasta que no haya más diálogos. Aunque al principio 

puede parecer tedioso, con el tiempo el verdadero trabajo se concentra en hacer una buena 

traducción del mensaje original. 

 

Figura 1. Interfaz de VisualSubSync. 
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5. El proceso de traducción 
En primer lugar, se verán los problemas de carácter general y, a continuación, problemas es-

pecíficos encontrados a lo largo de la traducción. 

5.1. Problemas generales 
Aunque aún no he realizado ningún curso sobre subtitulación, mi interés por esta modalidad 

de traducción me ha hecho leer algunos libros y artículos dedicados a la traducción audiovi-

sual. Por ello,  aunque el programa VisualSubSync detecta los subtítulos que exceden el núme-

ro de caracteres permitido por línea según el tiempo de duración del diálogo, consulté el libro 

Teoría y práctica de la subtitulación inglés – español, de Díaz Cintas (2003), para cerciorarme 

del máximo de caracteres permitidos por línea. En la página 118 podemos leer lo siguiente: 

Puesto que cada segundo supone el paso por pantalla de 24 fotogramas en cine (25 en televi-

sión), la ecuación supondrá la posibilidad de inclusión de 12 pulsaciones por segundo. En un 

cálculo con redondeo a la baja, seis segundos máximos de exposición en pantalla significan, 

pues, un total de 70 (72) caracteres, lo que equivale a 35 por línea. 

Así pues, comprobé el máximo de caracteres que permite el VisualSubSync en Edit > Preferen-

ces > Error checking > Too long display time y corregí el valor predeterminado (50) por 35. 

Otra duda que me surgió antes de comenzar la traducción era saber cómo dividir las líneas de 

un subtítulo, es decir,  cuál es la mejor forma de alinear los subtítulos y en qué momento se 

debe pasar a la siguiente línea. De nuevo, Díaz Cintas (ibíd.: 149) ofrece la solución: 

Con subtítulos bilineales en los que las dos líneas son de distinta longitud se recomienda que, 

en la medida de lo posible, la línea superior sea la más corta, ya que, de este modo, hay una 

menor contaminación de la imagen. [...] En cualquier caso, lo más importante es que la división 

de líneas sea lo más apropiada posible desde un punto de vista semotáctico. (énfasis mío) 

A pesar de esta valiosa explicación, quise buscar una explicación más sencilla y práctica. Mayo-

ral (1993: 56) ofrece las siguientes recomendaciones:  

[E]n primer lugar intentaremos terminar la primera línea en un punto y aparte. De no ser posi-

ble lo anterior, intentaremos terminar la primera línea en un punto y coma o en una coma. De 

no resultar tampoco posible, intentaremos terminarla en la separación entre el sujeto y el ver-

bo o en la separación entre el verbo y los complementos. De no ser posible, intentaremos no 

fragmentar un complemento. Después, no fragmentar una palabra. 

Otra consideración que tuve en cuenta antes de aventurarme a traducir fue utilizar siempre las 

formas contractas de algunos verbos en inglés (por ejemplo, I have > I’ve) para ahorrar carac-

teres a menos de que se quisiera enfatizar 

Por último, estimo oportuno haber optado por el uso de un inglés internacional, ya que mu-

chos de los posibles espectadores del cortometraje subtitulado no tendrán el inglés como len-

gua materna. 
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5.2. Problemas específicos 
El título del cortometraje plantearía un problema muy serio en otro tipo de texto debido a que 

es un palíndromo y pierde todo su efecto si la audiencia no lo identifica. Por suerte, en el mo-

mento de aparición del título (1 minuto y 10 segundos), éste aparece con las letras del revés y 

cambia hasta tener la letras en su sitio (figura 2). Por ello, la opción de traducir el título por The 

Natural Route, que de hecho así aparece en la página web del cortometraje, es viable. 

 

  

Figura 2. Título del cortometraje. 

 

Los nombres de los personajes que se mencionan (Divad, Arual y Siul) también son palíndro-

mos que la audiencia debe identificar. Afortunadamente, Divad (David) y Arual (Laura) son 

nombres fácilmente reconocibles por no hispanohablantes dado su origen, pero no sucede lo 

mismo con Siul (Luis), ya que este nombre suele escribirse como Louis en otros idiomas como 

el inglés y el francés. Por tanto, he decidido utilizar Sioul en vez de Siul, pues así es más fácil 

identificar dicho nombre como palíndromo. Además, es poco probable que la audiencia no 

hispanohablante se sienta extrañado por ver un nombre no español en caso de que tenga co-

nocimientos de español ya que apenas cambia y, en cualquier caso, el cortometraje no está 

ligado de manera especial a la cultura española. 

Un problema al que me he tenido que enfrentar ha sido el uso de conectores entre una ora-

ción y otra para que no quedara un resultado demasiado formal o brusco. Otro inconveniente 

añadido es que conectores como sin embargo o por tanto ocupan un espacio precioso en el 

subtítulo. En consecuencia, mi solución ha sido intentar pensar en inglés y compensar el co-

nector con un elemento característico de la lengua oral en inglés como just. Por ejemplo: 

Versión origina en español Versión subtitulada en inglés 

Me encanta la basura. 
De ella sacamos gratis todo lo que necesitamos. 

 
En cambio, el dinero es algo repugnante. 

I love rubbish. 
We get everything we need from it. 

 
Money just sucks. 

 

Tabla 1. Just como compensación del conector En cambio. 
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Dado que ha sido fundamental economizar el número de caracteres por subtítulo, he prescin-

dido generalmente de elementos superfluos que no modifican el sentido original y que, si bien 

pueden añadir algún pequeño matiz, se compensa a veces por el tono de la voz de fondo. Bue-

nos ejemplos de ello son los siguientes: 

Versión original en español Versión subtitulada en inglés 

La verdad, no parecemos un matrimonio. We don’t seem to be married... 
 

Tabla 2. Supresión de un elemento superfluo y compensación con puntos suspensivos. 

Versión original en español Versión subtitulada en inglés 

No necesito usar gafas, y ya no me quedo 
dormido viendo la tele o en el autobús. 

Now I don't use glasses 
nor fall asleep watching TV. 

 

Tabla 3. Supresión de un elemento superfluo. 

No obstante, en algunas ocasiones se han eliminado elementos de una oración importantes 

por motivos de concisión, aunque se ha intentado suplir tal supresión con un término que de-

note el elemento suprimido. Por ejemplo: 

Versión original en español Versión subtitulada en inglés 

Solamente un ordenador que cubriera toda la 

superficie de Madagascar tendría la misma 
memoria que nuestro cerebro. 

Only supercomputers can remember 
as good as we do. 

 

Tabla 4. Supresión de un elemento importante y compensación con otro término. 

En la traducción audiovisual hay que tener presente que algunos miembros de la audiencia 

pueden tener conocimientos de la lengua original de la pista de audio, por lo que, sin caer en 

la literalidad, he intentado no desviarme demasiado del mensaje de partida a menos que fuera 

necesario. Esto es especialmente importante para los pequeños matices que desempeñan las 

interjecciones o muletillas en un idioma. Por tanto, he creído conveniente ponerme en la piel 

de un hablante de habla inglesa para ofrecer la siguiente solución: 

Versión original en español Versión subtitulada en inglés 

No sé, 
tal vez sea la mejor solución. 

Well, 

maybe it’s better that way. 
 

Tabla 5. Adaptación de una muletilla. 
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Al igual que en el título, el apoyo visual ha servido de refuerzo para algunos subtítulos que 

requerían muchos más caracteres de los permitidos para reexpresar fielmente el mensaje ori-

ginal. La figura 4 muestra cómo la concisión de la traducción de la frase quizás tenga que ver 

con el chico que nos acompaña por maybe it’s for that boy se ve suplida por la imagen, ya que 

that boy hace referencia directamente a la imagen. 

 

Figura 2. Apoyo visual y referencia a la imagen. 

6. La revisión 
Como la realización del encargo la llevé a cabo en Navidad y la fecha de entrega era sobre la 

mitad de enero, opté por dejar un espacio de tiempo prudencial para no tener la traducción 

tan presente y así revisarla con nuevos ojos. 

En primer lugar, me he centrado en ajustar lo máximo posible los tiempos de entrada y salida 

de los subtítulos teniendo en cuenta los cambios de plano. En segundo lugar, he añadido pun-

tos al final de los subtítulos a los que se me había olvidado ponérselo. En tercer lugar, he co-

rregido la división de las líneas para que ningún sintagma se quede partido. Por último, he 

visionado el cortometraje subtitulado gracias a la ayuda de los programas DirectVobSub y 

BSPlayer y he anotado todos los aspectos que podía mejorar de la traducción. 

Está claro que los demás siempre pueden aportar ideas nuevas y corregir aspectos que uno 

pasa por alto al traducir, por lo que decidí buscar la opinión de otra persona. Al tratarse de una 

traducción hacia el inglés lo ideal hubiera sido buscar a alguien cuya lengua materna fuera 

inglés, pero me ha sido imposible contar con la ayuda de un extranjero. Por tanto, acordé con 

una compañera de clase, Susana Merino González, revisar su encargo individual a cambio de 

que ella revisara el mío. Así pues, una vez finalizado el encargo le entregué el vídeo y los sub-

títulos para que me diera su opinión, si bien antes le expliqué algunas decisiones que tomé 

para traducir. 

Susana me indicó algunas dudas sobre la fidelidad del texto traducido con respecto al original 

e incluso de expresión, ya que por ejemplo había traducido los médicos ahora intentan hacer-

me desaparecer por doctors now try to kill me, algo que le chocó por el uso de kill. Por ello, 

decidí ser más neutral y opté por el verbo to eliminate. Gracias a Susana pude volver a subra-

yar la importancia de la imagen, ya que en una ocasión no había reconocido la figura de una 

persona y hacía referencia a ella con he cuando en realidad se trataba de una mujer. 
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7. Inserción de los subtítulos dentro del vídeo 
Una vez tenía la versión definitiva de los subtítulos, sólo restaba incrustar los subtítulos en el 

vídeo para que no hiciera falta usar programas externos para poder visualizarlos sobre el 

vídeo. Como ya tenía cierta experiencia no me resultó difícil llevar a cabo este último paso, 

aunque preferí consultar una guía sencilla de subtitulación como el Manual de VirtualDub + 

Subtitler para refrescar conocimientos. 

Antes de seguir los pasos de dicha guía, ejecuté el programa VisualSubSync para cargar los 

subtítulos del proyecto y exportarlos a formato .ssa (File > Save as) para que los pudiera leer el 

programa VirtualDub. Una vez hecho esto, ejecuté el programa VirtualDub, abrí (File > Open) el 

cortometraje descargado de la red eMule en formato AVI (que en el encargo habría proporcio-

nado el director), cargué los subtítulos en formato .ssa (Video > Filters > Subtitler), seleccioné 

el códec de vídeo necesario para la compresión del vídeo (Video > Compression) y guardé el 

archivo resultante (File > Save as...). El vídeo resultante tardó unos cuatro minutos en generar-

se. 

8. Conclusión 
La experiencia ha sido totalmente enriquecedora. Si bien no he ampliado profundamente mis 

conocimientos técnicos de subtitulación —aunque generalmente mi labor había sido sólo la de 

traductor y no tenía que fijar los tiempos de entrada y salida de los subtítulos—, me ha pareci-

do muy provechoso realizar un ejercicio de reformulación de textos subordinados a imagen y 

sonido desde mi lengua materna a una lengua extranjera. Pienso que para subtitular hay que 

tener mucha agilidad mental para buscar soluciones concisas en el menor tiempo posible, algo 

que, con la práctica, se puede adquirir. Incluso a pesar de los escasos once minutos de dura-

ción del cortometraje, he notado que hacia el final del mismo daba con aciertos de una mane-

ra más rápida. Varios han sido los problemas que he encontrado en los que la imagen ha sido 

fundamental para solventarlos, algo que, en otro cortometraje o largometraje podría no ser 

tan sencillo. Realmente, cada vídeo presenta una serie de particularidades únicas. Ésa es la 

fascinante característica de la traducción: siempre hay retos por afrontar. Y si además se su-

peran disfrutando de la satisfacción personal de la a veces proeza, creo que, a pesar de los 

posibles fallos que contenga mi traducción y de que nunca se puede dejar de revisar un texto, 

he disfrutado a la vez que he aprendido. Por ello, me alegro de habérseme brindado la oportu-

nidad de tener una buena razón para lanzarme a la subtitulación de un cortometraje hacía una 

lengua extranjera. 
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